
Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-1

Dans cette leçon vous apprendrez à analyser un modèle et à créer des formules.

Finalisation de l'objectif de conception

Sujets traités :

Etude de cas : Finalisation de l'objectif de 
conception
Objectif de la conception
Etapes du processus
Application de propriétés de matériau
Analyse du modèle
Création de formules et de paramètres
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Etude de cas : Finalisation de l'objectif de conception

L'étude de cas de cette leçon est la table utilisée dans l'assemblage de perceuse à colonne 
illustrée ci-dessous. Elle fait partie du sous-assemblage Stand (Support). Cette étude de cas se 
focalise sur l'application de matériau au modèle, par analyse de ses propriétés de masse, 
vérification de ses cotes et création de formules pour assurer que l'objectif de conception est 
maintenu lors de l'application de modifications.
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Objectif de la conception (1/2)

a L

b

� Le modèle doit être fabriqué en aluminium.
• Le matériau choisi pour cette pièce est 

l'aluminium. Les propriétés du matériau 
aluminium, dans la bibliothèque CATIA, 
répondent aux pré-requis.

� La géométrie du modèle doit répondre aux 
critères suivants (qui peuvent être vérifiés par 
des outils de mesure et forcés au moyen de 
formules) :

a. Création d'un trou toujours situé à 2 mm au-
dessus des trous oblongs inférieurs et centré
horizontalement.

b. La largeur totale doit être de 80 % de la 
longueur (L).

La pièce table doit correspondre aux pré-
requis suivants de l'objectif de conception :



Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-4

Objectif de la conception (2/2)

L

c

d

� La géométrie du modèle doit répondre aux 
critères suivants (suite) :

c. L'épaisseur du modèle est toujours de 1 % 
de la longueur (L).

d. L'épaisseur des nervures doit représenter 
le double de l'épaisseur du modèle.
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Etapes du processus

1. Application de propriétés de matériau. 
2. Analyse du modèle.
3. Création de formules.

Suivez ces étapes pour finaliser l'objectif de conception :
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Application de propriétés de matériau
Dans cette section vous apprendrez à appliquer des matériaux sur votre modèle et à
visualiser le résultat.

1. Application de 
propriétés de matériau. 

2. Mesure du modèle.
3. Création de formules et de 

paramètres.

Suivez ces étapes :



Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-7

Propriétés de matériau

Un matériau peut être appliqué à n'importe quelle 
pièce dans CATIA. Les propriétés de matériau (par 
exemple, la densité) affectent les propriétés de 
masse de la pièce. CATIA possède une 
bibliothèque de matériaux par défaut déjà installée. 
Votre entreprise peut également avoir des 
matériaux personnalisés, créés pour répondre à
ses besoins.
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Application de propriétés de matériau (1/2)

5 4

3

2
1

1. Sélectionnez la pièce dans l'arbre des 
spécifications.

2. Cliquez sur l'icône Appliquer un 
matériau.

3. Sélectionnez le matériau (par exemple, 
Aluminium dans l'onglet Metal (Métaux)).

4. Sélectionner Apply Material (Appliquer un 
matériau).

5. Cliquez sur OK. Le matériau est ajouté au 
modèle.

Pour appliquer un matériau à un modèle, 
suivez ces étapes :
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Application de propriétés de matériau (2/2)

2

1

3

4

1. Sélectionnez le matériau dans l'arbre des 
spécifications. 

2. Cliquez sur Propriétés dans le menu 
contextuel.

3. Cliquez sur l'onglet Analysis (Analyse) 
pour modifier les propriétés du matériau.

4. Cliquez sur OK pour appliquer les 
modifications aux propriétés du matériau.

Vous pouvez modifier les propriétés du 
matériau en suivant ces étapes :
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Visualisation de matériau sur le modèle

2

1

1. Cliquez sur View > Render Style > 
Shading with Material (Affichage > Style 
de rendu > Rendu réaliste avec texture) ou 
cliquez sur l'icône Rendu réaliste avec 
texture.

2. Vous obtenez le rendu du matériau sur le 
modèle.

Vous pouvez voir le matériau sur le modèle en 
utilisant une vue personnalisée. Pour visualiser 
le matériau :
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Mesure du modèle
Dans cette section vous apprendrez à utiliser les outils de mesure disponibles dans 
CATIA.

1. Application de propriétés de 
matériau. 

2. Mesure du modèle.
3. Création de formules et de 

paramètres.

Suivez ces étapes :
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Outils d'analyse

A B C

Plusieurs outils sont disponibles dans l'atelier Part 
Design pour analyser un modèle. 

Il existe trois types d'outil de mesure dans la barre 
d'outils Measure (Mesure) :

A. L'outil Mesure entre mesure la distance entre 
éléments dans un modèle.

B. L'outil Mesure d'entités mesure un élément 
spécifique dans un modèle.

C. L'outil Mesure d'inertie calcule les propriétés 
de masse du modèle.

Vous pouvez enregistrer toutes les mesures dans 
l'arbre des spécifications en sélectionnant l'option 
Garder les mesures.
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Sélection d'éléments (1/2)

A

B

C

D

E

Ceci vous permet de vérifier que vous 
sélectionnez bien l'élément que vous 
voulez mesurer.

Lors de la sélection d'éléments à
mesurer, le pointeur indique le type 
d'élément que vous sélectionnez.  Voici la 
liste des types d'éléments qui peuvent 
s'afficher :

A. Surface cylindrique
B. Plan ou surface plane
C. Centre d'un arc
D. Droite
E. Point
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Sélection d'éléments (2/2)

Une autre façon d'être sûr de sélectionner 
l'élément désiré est d'isoler le type 
d'élément. Vous pouvez le faire en utilisant 
les menus du mode de sélection.
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Mode Mesure entre

A

C

B

A. En mode Standard, les deux éléments 
doivent être sélectionnés avec leurs 
mesures.

B. En Mode chaîne, le second élément 
sélectionné d'une mesure devient 
automatiquement le premier de la mesure 
suivante. 

C. En mode Eventail, des mesures sont 
prises entre le premier élément et chaque 
élément sélectionné après.

Le mode Mesure entre est utilisé pour mesurer 
entre deux éléments dans un modèle.

Il existe trois modes différents :
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Mesure entre (1/2)

1

4

3

2

1. Cliquez sur l'icône Mesure entre.

2. Sélectionnez le type de définition. Dans cet 

exemple, le mode Standard.

3. Sélectionnez l'élément de référence.

4. Sélectionnez l'élément cible.

Suivez ces étapes pour faire des mesures 
entre les éléments d'un modèle :
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Mesure entre (2/2)

5a

5b

6 78

5. La distance et l'angle minimum sont 
affichés sur le modèle et dans la boîte de 
dialogue des résultats.

6. Sélectionnez l'option Keep Measure
(Garder les mesures) pour enregistrer les 
mesures.

7. Cliquez sur OK pour terminer la création 
de mesures. 

8. Si l'option Keep Measure (Garder les 
mesures) a été sélectionnée, les mesures 
restent sur le modèle et sont ajoutées 
dans l'arbre des spécifications.

Suivez ces étapes pour mesurer entre entités 
dans un modèle (suite) :
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Mesure d'entités (1/2)

1

2

3

3

1. Cliquez sur l'icône Mesure d'entités.
2. Sélectionnez l'élément géométrique à

mesurer.
3. Les propriétés des éléments géométriques 

sélectionnés sont affichées sur le modèle et 
dans la fenêtre de résultats.

L'outil Measure Item (Mesure d'entités) vous 
permet de mesurer les éléments géométriques 
individuellement. Suivez ces étapes pour 
mesurer une entité :
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Mesure d'entités (2/2)

4
5

6

4. Sélectionnez l'option Keep Measure
(Garder les mesures) pour enregistrer les 
mesures.

5. Cliquez sur OK pour terminer la création 
de mesures.

6. Si l'option Keep Measure (Garder les 
mesures) a été sélectionnée, les mesures 
restent sur le modèle et sont ajoutées 
dans l'arbre des spécifications.

Suivez ces étapes pour mesurer une entité
(suite) :
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Option Composants (1/2)

1. Cliquez sur l'icône Mesure entre.
2. Sélectionnez les éléments géométriques à

mesurer.
3. Sélectionnez Customize (Personnaliser) et 

sélectionnez l'option Components 
(Composants). Les distances entre 
composants sont affichées dans la fenêtre 
de résultats.

Par défaut, les mesures donnent la distance la 
plus courte entre deux éléments. Pour obtenir les 
distances entre composants (par exemple, les 
distances dans les directions X, Y et Z) relatives 
au système de coordonnées, procédez comme 
suit :

1

2

3

3
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Option Composants (2/2)

Repère par défaut

Repère personnalisé

4. Les directions par défaut X, Y et Z sont 
basées sur le système de repère par défaut 
du modèle. Pour choisir un autre repère, 
choisissez l'option Other Axis (Autre 
repère).

5. Sélectionnez Axis System.2
6. Les distances entre composants sont 

ensuite basées sur le repère sélectionné.

4 5

6
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Propriétés de masse A

B

Les résultats des calculs d'inertie 2D et 3D 
peuvent être personnalisés pour obtenir les 
formats de résultats requis. La boîte de 
dialogue Measure Inertia Customization
(Personnalisation de mesure d'objet) affiche 
les types de résultats que vous pouvez inclure 
dans le rapport, y compris des propriétés de 
masse (par exemple : Volume, Masse, Centre 
de gravité).

Les propriétés de masse peuvent être 
calculées en utilisant l'outil Measure Inertia
(Mesure d'inertie). Cet outil mesure les 
entités suivantes :

A. Propriétés 3D, qui sont calculées sur des 
surfaces (par exemple, des faces de 
composants) et des volumes (par 
exemple, des composants et des Corps de 
pièce).

B. Propriétés 2D, qui calculent des propriétés 
d'inertie sur des surfaces planes 2D.



Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-23

Mesure d'inertie (1/2)

1

3

2

4

1. Cliquez sur l'icône Mesure d'inertie.
2. Sélectionnez PartBody (Corps principal) 

dans l'arbre des spécifications.
3. Visualisez les résultats dans la fenêtre 

d'affichage. 
4. Le centre de gravité est affiché sur le 

modèle.

Suivez ces étapes pour calculer des propriétés 
de masse 3D à l'aide de l'outil Mesure 
d'inertie :



Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-24

Mesure d'inertie (2/2)

56

7

5

5. Si nécessaire, sélectionnez Customize
(Personnaliser) pour modifier les résultats affichés.

6. Sélectionnez l'option Keep measure (Garder les 
mesures) pour enregistrer les résultats.

7. Cliquez sur OK pour terminer la création de 
mesures.

Suivez ces étapes pour calculer des propriétés 
de masse 3D à l'aide de l'outil Mesure d'inertie 
(suite) :
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Création de la géométrie de mesure (1/2) 

Premier point

Second point

Droite

Tous les outils de mesure contiennent une option 
pour créer une géométrie. Des points, des droites et 
des systèmes de repère peuvent être créés pour 
illustrer les mesures. 

Par défaut, la géométrie de mesure résultante est 
associative. Si les éléments de la géométrie de 
mesure changent, le résultat est le même. Vous 
pouvez aussi créer une géométrie non associative 
pour que la géométrie de mesure reste statique lors 
de modifications dans le modèle.
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Création de la géométrie de mesure (2/2)

8

7

6

5

4

3
2

1

8

1. Activez l'outil de mesure et effectuez les 
mesures.

2. Sélectionnez l'option Keep Measure
(Garder la mesure).

3. Sélectionnez Create Geometry (Créer la 
géométrie).

4. Sélectionnez l'icône qui correspond à la 
géométrie souhaitée. En effectuant la 
mesure d'inertie par exemple, vous pouvez 
créer un point sur le centre de gravité ou à
l'origine d'un système d'axes.

5. Définissez l'associativité. 
6. Cliquez sur OK.
7. Cliquez sur OK pour terminer la création 

de mesures.
8. La géométrie de mesure est ajoutée dans 

le modèle et dans l'arbre des 
spécifications.

Suivez ces étapes pour créer la géométrie de 
mesure :
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Mise à jour

Si l'option Keep Measure (Garder les 
mesures) est sélectionnée, les mesures sont 
ajoutées dans le modèle. Les mesures ne sont 
pas mises à jour automatiquement suite à des 
modifications du modèle, même si elles sont 
associatives. Si vous devez mettre à jour une 
mesure, l'icône Mesure dans l'arbre des 
spécifications s'affiche avec le symbole de 
mise à jour. Cliquez à l'aide du bouton droit de 
la souris sur la mesure, puis cliquez sur Local 
Update (Mise à jour locale).

Pour procéder à une mise à jour automatique 
des mesures, appliquez l'option Automatic
Update (Mise à jour automatique) à partir du 
menu Tools > Options > Infrastructure > 
Part Infrastructure > General (Outils > 
Options > Infrastructure > Part Infrastructure > 
Général).
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Création de formules et de paramètres
Dans cette section vous apprendrez à créer des formules pour gérer l'objectif de 
conception.

1. Application de propriétés de 
matériau. 

2. Mesure du modèle.
3. Création de formules et 

de paramètres.

Suivez ces étapes :
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Formules

Tous les composants et éléments dans CATIA 
sont uniques. Une fois un élément créé, il reçoit 
un identifiant unique (paramètre). Des identifiants 
uniques sont également donnés aux mesures et 
aux contraintes. Des paramètres 
complémentaires sont créés pour les matériaux, 
les mesures enregistrées, etc. 

Ces paramètres peuvent être utilisés pour la 
création de formules. Les formules sont des 
équations reliant des paramètres, et elles 
peuvent être utilisées pour assurer que l'objectif 
de conception est maintenu.

Les formules sont stockées sous le noeud 
Relations de l'arbre de spécifications. Les 
paramètres utilisateur sont stockés sous le 
noeud Parameters (Paramètres) de 
l'arborescence.
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Identification des paramètres

Des identifiants internes sont associés à
chaque paramètre dans CATIA. Il est parfois 
difficile de déterminer, sur la base de son 
identifiant interne, quel paramètre est requis. 

Une fois un élément sélectionné, seuls les 
paramètres qui lui sont associés s'affichent 
dans la boîte de dialogue Formula (Formule). 
Ils sont également affichés sur le modèle. 

La sélection d'un paramètre dans la fenêtre le 
mettra en surbrillance sur le modèle, et vice-
versa.
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Création de paramètres utilisateur (1/2)

Les paramètres utilisateur peuvent contenir des informations de texte, tel que le 
concepteur, la date de révision, etc., ainsi que diverses valeurs numériques. Des 
paramètres peuvent être associés à des mesures dans votre modèle et être utilisés pour 
piloter votre conception.



Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-49

Création de paramètres utilisateur (2/2)

1

23

4 5

7 6

1. Cliquez sur l'icône Formule. 
2. Sélectionnez le type de paramètre à créer à

partir de la liste New Parameter of type (Créer 
un paramètre de type)  (par exemple, 
sélectionnez le type Length (Longueur)).

3. Cliquez sur l'icône New Parameter of Type 
(Créer un paramètre de type). 

4. Spécifiez un nom significatif.
5. Spécifiez une valeur.
6. Cliquez sur Apply (Appliquer).
7. Cliquez sur OK.

Suivez ces étapes pour définir un paramètre 
utilisateur.

Un paramètre utilisateur est isolé
jusqu'à ce qu'il soit associé à un 
paramètre géométrique du modèle.
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Renommer des paramètres

1

2

3

4
5

1. Cliquez sur l'icône Formule.
2. Localisez le paramètre dans la fenêtre de 

paramètres.
3. Remplacez le nom dans le champ Edit 

Name or Value of current parameter
(Editer le nom ou la valeur du paramètre 
sélectionné) par un nom plus significatif.

4. Cliquez sur Apply (Appliquer) pour 
confirmer la modification.

5. Cliquez sur OK pour fermer la fenêtre.

Les paramètres peuvent être renommés en 
utilisant la boîte de dialogue Formula (Formule). 
Il est pratique de donner à un paramètre un 
nom significatif qui permette à la fois de 
l'identifier et de comprendre sa fonction.
En outre, une formule qui contient le paramètre 
sera facile à comprendre.

Suivez ces étapes pour renommer un 
paramètre :

Il est déconseillé de renommer un paramètre 
généré par le système. Si vous le renommez, 
vous ne pouvez pas voir immédiatement dans 
quel composant il est utilisé. Le nom du 
paramètre système comprend le chemin (par 
exemple,  Base\Pad.1\FirstLimit\Length), ce qui 
rend évident l'emplacement du paramètre. 
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Filtres

Les boîtes de dialogue Formulas 
(Formules) et Formula Editor (Editeur de 
formules) ont des filtres que vous pouvez 
utiliser pour trouver rapidement un 
paramètre. 

Dans la boîte de dialogue Formulas 
(Formules) vous pouvez filtrer par nom ou 
par type. Dans la fenêtre Formula Editor 
(Editeur de formules), vous pouvez affiner 
les critères de recherche du paramètre en 
utilisant des colonnes Dictionary
(Dictionnaire), Members of Parameters
(Membres de paramètres) et Members of 
All (Membres de tous).

Utilisez le filtre Renamed parameters
(Paramètres renommés) pour afficher 
uniquement les paramètres du modèle que 
vous avez renommés.
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Création de formules

A

B

A. Utilisez la boîte de dialogue Formulas 
(Formules).

B. Edition de la valeur de dimension.

L'utilisation habituelle des formules est de lier 
une dimension à une autre. Il existe deux 
méthodes de contrôle des dimensions par une 
formule :
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Création d'une formule avec la boîte de dialogue Formules (1/2)

4

1

1. Cliquez sur l'icône Formule.
2. Sélectionnez le composant contenant la 

mesure. Toutes les mesures associées 
au composant sélectionné s'affichent.

3. Sélectionnez une mesure sur le modèle 
(par exemple, Length). La mesure 
correspondante est mise en évidence 
dans la boîte de dialogue Formules. 
Observez l'identificateur de la mesure de 
longueur. 
(PartBody\Sketch.1\Length.8\Length).

4. Cliquez sur le bouton Add Formula 
(Ajouter formule).

Dans cet exemple, la longueur de la boîte est 
le double de la largeur de la boîte. 

Suivez ces étapes pour créer une formule qui 
contrôle la mesure en utilisant la boîte de 
dialogueFormulas (Formules) :
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Création d'une formule avec la boîte de dialogue Formules (2/2)

6

7

5

5. Spécifiez la formule. Pour associer la 
mesure de longueur à la mesure de 
largeur, double-cliquez sur la dimension de 
largeur dans la fenêtre Formula Editor 
(Editeur de formules) 
(PartBody\Sketch.1\Length.7\Length), ou 
sélectionnez-la sur le modèle. Entrez [* 2] 
pour associer la longueur comme double 
de la largeur.

6. Cliquez sur OK.
7. Cliquez sur OK dans la boîte de dialogue 

Formules.

Suivez ces étapes pour créer une formule qui 
contrôle la mesure en utilisant la boîte de 
dialogue Formulas (Formules) (suite) :
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Création d'une formule en éditant la valeur de mesure (1/2)

1

2

Longueur

Largeur

1. Editez le composant.
2. Cliquez deux fois sur la mesure pour 

l'éditer (par exemple, la longueur).
3. Cliquez avec le bouton droit de la souris 

dans la zone de valeur et sélectionnez 
Edit formula (Editer formule) dans le 
menu contextuel.

Pour utiliser la boîte de dialogue de la valeur 
de mesure pour associer la longueur de 
l'extrusion comme double de sa largeur, 
procédez comme suit :
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Création d'une formule en éditant la valeur de mesure (2/2)

4

5

6

4. Spécifiez la formule. Pour associer la 
mesure avec un autre paramètre, 
sélectionnez le paramètre requis dans la 
boîte de dialogue ou sélectionnez-le à
l'aide du modèle 3D. Entrez [* 2] pour 
associer la longueur comme double de la 
largeur.

5. Cliquez sur OK.
6. Cliquez sur OK dans la boîte de dialogue 

Constraint Definition (Edition de 
contrainte).

Pour utiliser la boîte de dialogue de la valeur 
de mesure pour associer la longueur de 
l'extrusion comme double de sa largeur, 
procédez comme suit (suite) :



Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-57

Recommandations sur les formules
Dans cette section, vous recevrez quelques recommandations qui pourront vous être 
utiles lors de la création de formules.
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Unités (1/2)

Y = 50mm

X = Y + 2m = 2050mm

Il est important de réfléchir aux unités de 
mesure quand vous écrivez des formules.

S'il n'y a aucune unité spécifiée dans une 
formule, les unités par défaut sont utilisées 
(par exemple, mètre). C'est particulièrement 
important si vous ajoutez ou désactivez une 
valeur numérique.

Par exemple, prenez la formule qui associe la 
longueur de l'extrusion (X) à la largeur de 
l'extrusion (Y) + 2mm.

Si la formule est spécifiée de la façon suivante 
:

X = Y + 2

CATIA génère un message d'erreur et accepte 
deux mètres. Cela rendra la valeur de X trop 
grande.
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Unités (2/2)

X = Y + 2mm = 52mm

Y = 50mm

La formule doit être spécifiée de la 
façon suivante :

X = Y + 2mm.
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Affichage des formules et des paramètres utilisateur

Les paramètres utilisateur peuvent être 
également affichés dans l'arbre des 
spécifications. Cliquez sur Outils > 
Options > Infrastructure > 
Infrastructure Part. Sélectionnez l'option 
Parameters (Paramètres) dans l'onglet 
Display (Affichage). Sélectionnez 
l'option Relations pour afficher les 
formules.

La valeur des paramètres peut être 
affichée en cliquant sur Tools > Options 
> General > Parameters and Measure
(Outils > Options > Général > 
Paramètres et mesure). Sélectionnez 
l'option With Value (Avec valeur) dans 
l'onglet Knowledge (Connaissance).



Principes de base CATIA V5- Leçon 7 : Finalisation de l'objectif de conception
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              7-61

Pour résumer...

� Application du matériau.
� Vérification des cotes.
� Calcul de la masse.
� Création de formules pour maintenir l'objectif 

de conception.

En utilisant les informations données dans 
cette leçon, vous devriez être capable de 
finaliser la conception de la table.




